Making Documents Accessible to Everyone

Donna Lettow
MSDE Division of Rehabilitation Services
Digital Accessibility Specialist
Donna.Lettow@Maryland.gov
What is “Accessibility”?
What is “Digital” Accessibility?

According to the US Department of Justice: “Accessible” means a person with a disability is afforded the opportunity to acquire the same information, engage in the same interactions, and enjoy the same services as a person without a disability in an equally effective and equally integrated manner, with substantially equivalent ease of use.
US Department of Justice, con’t

“The person with a disability must be able to obtain the information as fully, equally and independently as a person without a disability.”
Who is “Everyone”?

You, your co-workers, your consumers/clients/students, your parents, your neighbors who are:
Blind
Visually Impaired

supper dish: (Cats will not usually notice your have strange attire. They have little or no interest in fashion as a rule.)

D. Once you are inside the
Colorblind

ISHIHARA COLOR BLINDNESS TEST PLATE 1
Elderly
What “Documents”?

- Web pages and web site attachments
- Microsoft Office/Google Docs documents (word processing, spreadsheets, presentation slides)
- PDFs
- Forms, questionnaires, surveys
- Email attachments
What makes a document accessible?
Alternate (ALT) Text

- Whatever information a sighted person gets from looking at a picture, chart or other graphic must also be given to the person who can’t see the graphic.
Information Blind User Gets:

Please read this very important message:

To continue, hit ENTER.
Please read this very important message:

All of your email is about to be deleted!

To continue, hit ENTER.

ALT text for the graphic should be: “All of your email is about to be deleted!”
All images have equivalent alternative text.

“Queen Elizabeth the Second”

“Coronation photo of Queen Elizabeth the Second”

“Formal portrait of Queen Elizabeth the Second of England, taken in the mid-1950s”
Pictures As Links

Link destination = www.Windsor.org.uk/royal_blog

“Queen Elizabeth’s blog”

Pictures as links and button graphics should have alternate text that says what’s going to happen/where will I go if I click this.
“Still #1 in the nation. Education Week ranks Maryland #1 in the nation for the third straight year..."
Alternate text = “Pie chart of pet popularity. Dogs 40%. Cats 25%. Birds 20%. Lizards 15.”
How To: Add ALT Text

1. Insert graphic
2. Right click the graphic
3. Click: Format Picture
4. Click: Alt Text
5. Leave Title blank
6. Enter alt text in Description

Word 2010
How To: Add ALT Text

Word 2007

1. Insert graphic
2. Click the graphic
3. Choose **Picture Tools Format** tab
4. Click: the **little arrow next to Size**
5. Click: **Alt Text** tab
6. Enter alt text in **Alternative Text**

Word 2013/2016

1. Insert graphic
2. Right click the graphic
3. Click: **Format Picture**
4. Click: **Size & Properties icon**
5. Click: **Alt Text**
6. Leave **Title** blank
7. Enter alt text in **Description**
Trust Microsoft

Use Built-in Formatting:

- Headings via Styles
- Table of Contents
- Bulleted Lists
- Numbered Lists
- Columns
- Tables
What’s a Heading?

THE COLLEGE APPLICATION PROCESS

I. CHOOSE DESIRED COLLEGES
   A. Visit and evaluate college campuses
   B. Visit and evaluate college websites
      1. Look for interesting classes
      2. Note important statistics

II. PREPARE APPLICATION
   A. Write personal statement
      1. Choose interesting topic
Use Properly Marked Headings

The Constitution of the United States

We the People of the United States, in Order to form a more perfect Union, establish Justice, insure domestic Tranquility, provide for the common defence, promote the general Welfare, and secure the Blessings of Liberty to ourselves and our Posterity, do ordain and establish this Constitution for the United States of America.

Article. 1.

Section. 1.
All legislative Powers herein granted shall be vested in a Congress of the United States, which shall consist of a Senate and House of Representatives.

Section. 2.
The House of Representatives shall be composed of Members chosen every second Year by the People of the several States, and the Electors in each State shall have the Qualifications requisite for Electors of the most numerous Branch of the State Legislature.

Don’t just BOLD and highlight text using the keyboard. Use the “Styles” feature in Word.
How To: Add Headings

1. Type or insert heading text
2. Select line with heading text
3. In the Ribbon, in the Styles group, click the appropriate heading level (Heading 1, Heading 2, etc.)
How To: Format Heading

1. Select line you’ve already set to that heading level (e.g., Heading 1)
2. Use the Ribbon to style the heading the way you want it
3. In the Ribbon Styles group, right click appropriate heading (e.g., Heading 1)
4. Click: Update Heading 1 to Match Selection
Use Properly Marked Headings
## Contents

<table>
<thead>
<tr>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Our Pets Are Looking for Someone Like You</td>
<td>1</td>
</tr>
<tr>
<td>CATS</td>
<td>1</td>
</tr>
<tr>
<td>Sweet Bonded Pair of Kitties</td>
<td>1</td>
</tr>
<tr>
<td>Astro is Out of this World!</td>
<td>1</td>
</tr>
<tr>
<td>DOGS</td>
<td>2</td>
</tr>
<tr>
<td>A High-Energy Bundle of Fun</td>
<td>2</td>
</tr>
<tr>
<td>Your Kids Will Love This Dog</td>
<td>2</td>
</tr>
</tbody>
</table>
How To: Table of Contents

1. Put cursor where you want the table of contents to be
2. Choose References tab
3. Click: Table of Contents
4. Click: Automatic Table 1
Bulleted List

Lemon Bars Ingredients

For the filling:
- 6 extra-large eggs at room temperature
- 3 cups granulated sugar
- 2 tablespoons grated lemon zest (4 to 6 lemons)
- 1 cup freshly squeezed lemon juice
- 1 cup flour
- Confectioners' sugar, for dusting
Numbered List

Lemon Bars Instructions

1. Preheat the oven to 350 degrees F.
2. For the crust, cream the butter and sugar until light in the bowl of an electric mixer fitted with the paddle attachment.
3. Combine the flour and salt and, with the mixer on low, add to the butter until just mixed.
4. Dump the dough onto a well-floured board and gather into a ball.
5. Flatten the dough with floured hands and press it into a 9- by 13- by 2-inch baking sheet, building up a 1/2-inch edge on all sides.
How To: Format Lists

1. Put each item of the list on its own line
2. Select all the lines in your list
3. On the Ribbon, click:
   - For a bulleted list
   - For a numbered list
Formatting Information: Tabs

- Use TABS (not SPACES!) when you want simple information read across and then down.

"These are the years impacted by the impending audit:

2001 2002 2004 2005 2006"
Use Column Mode when you want information read down and then across.

<table>
<thead>
<tr>
<th>Cabinet Members Present</th>
<th>Cabinet Members Not Present</th>
</tr>
</thead>
<tbody>
<tr>
<td>Secretary of Agriculture</td>
<td>Secretary of State</td>
</tr>
<tr>
<td>Secretary of Commerce</td>
<td>Secretary of Transportation</td>
</tr>
<tr>
<td>Secretary of Defense</td>
<td>Secretary of Treasury</td>
</tr>
<tr>
<td>Secretary of Education</td>
<td>Secretary of Veterans Affairs</td>
</tr>
<tr>
<td>Secretary of Energy</td>
<td>Attorney General</td>
</tr>
<tr>
<td>Secretary of Health &amp; Human Services</td>
<td>Vice President</td>
</tr>
</tbody>
</table>
How To: Make Columns

Entire document in columns:
1. Put cursor at top of page
2. Click: Page Layout tab
3. Click: Columns
4. Click: # of Columns needed
How To: Make Columns

To control where column breaks:
1. Put cursor where you want column to break
2. Click: Page Layout tab
3. Click: Breaks
4. Click: Column
How To: Make Columns

To make a section into columns:

1. Put cursor where you want the columns to begin
2. Click: **Page Layout** tab
3. Click: **Breaks**
4. Click: **Continuous**
5. Put cursor where you want the columns to end
How To: Make Columns

Section, continued:

6. Click: Breaks
7. Click: Continuous
8. Put cursor anywhere between the continuous breaks
9. Click: Columns
10. Click: # of Columns needed
Use Tables to organize more complex information.

### Kennel Club Registrations

<table>
<thead>
<tr>
<th></th>
<th>2001</th>
<th>2002</th>
<th>2003</th>
<th>2004</th>
<th>2005</th>
<th>2006</th>
<th>2007</th>
<th>2008</th>
<th>2009</th>
<th>2010</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pomeranian</td>
<td>105</td>
<td>105</td>
<td>110</td>
<td>105</td>
<td>110</td>
<td>101</td>
<td>101</td>
<td>110</td>
<td>101</td>
<td>101</td>
</tr>
<tr>
<td>Poodle</td>
<td>52</td>
<td>52</td>
<td>48</td>
<td>52</td>
<td>48</td>
<td>44</td>
<td>44</td>
<td>48</td>
<td>44</td>
<td>44</td>
</tr>
<tr>
<td>Pug</td>
<td>74</td>
<td>74</td>
<td>76</td>
<td>74</td>
<td>76</td>
<td>80</td>
<td>80</td>
<td>76</td>
<td>80</td>
<td>80</td>
</tr>
</tbody>
</table>
Formatting Information: Tables

- Keep tables simple
- No blank rows – if you want to show space between, adjust the line spacing setting
- Avoid blank cells
- Avoid merging cells
## Formatting Information: Tables

**Identify header row:**

<table>
<thead>
<tr>
<th></th>
<th>2001</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pomeranian</td>
<td>105</td>
</tr>
<tr>
<td>Poodle</td>
<td>52</td>
</tr>
<tr>
<td>Pug</td>
<td>74</td>
</tr>
</tbody>
</table>

![Table Properties](image)

- **Repeat as header row at the top of each page**
- **Ensure header row is repeated on subsequent pages**
How To: Format Tables

Identify header row:

- Put cursor anywhere in header row
- Right click: Choose Table Properties
- Click: Row tab
- Allow Row to break across pages
- Repeat as header row at the top of each page
Make Purpose of Each Link Obvious

• Click here for our Programs
• Click here for our Services
• Click here for Today’s Specials
Make Purpose of Each Link Obvious

- Click here
- Click here
- Click here
Make Purpose of Each Link Obvious

- Our Programs
- Our Services
- Today’s Specials
Color Contrast at Least 4.5:1

Shall I compare thee to a summer’s day?
Thou art more lovely and more temperate.
Rough winds do shake the darling buds of May,
And summer’s lease hath all too short a date.
Sometime too hot the eye of heaven shines,
And often is his gold complexion dimmed;
And every fair from fair sometime declines,
By chance, or nature’s changing course, untrimmed;
But thy eternal summer shall not fade,
Nor lose possession of that fair thou ow’st,
Nor shall death brag thou wand’rest in his shade,
When in eternal lines to Time thou grow’st.
So long as men can breathe, or eyes can see,
So long lives this, and this gives life to thee.

Color contrast ratio = 3.5 : 1
FAIL

Shall I compare thee to a summer’s day?
Thou art more lovely and more temperate.
Rough winds do shake the darling buds of May,
And summer’s lease hath all too short a date.
Sometime too hot the eye of heaven shines,
And often is his gold complexion dimmed;
And every fair from fair sometime declines,
By chance, or nature’s changing course, untrimmed;
But thy eternal summer shall not fade,
Nor lose possession of that fair thou ow’st,
Nor shall death brag thou wand’rest in his shade,
When in eternal lines to Time thou grow’st.
So long as men can breathe, or eyes can see,
So long lives this, and this gives life to thee.

Color contrast ratio = 5.9 : 1
PASS
Test Color Contrast

**ANATOMY of a GOOD TEST**

1. COLLEGE AND CAREER READY
2. PROBLEM SOLVING & CRITICAL THINKING
3. FAIRNESS
4. INFORMS TEACHERS
5. EMPOWERS PARENTS

**HOW DO I KNOW WHAT A GOOD TEST LOOKS LIKE?**

1.5
2.4
1.3
1.5
1.2
1.9
1.7
How To: Test Color Contrast

1. Find the RGB numbers for the text and background colors
   - Go to where you originally set the color (text box fill, font color, cell color, background)
   - Click on the down arrow next to the current color
   - Click: **More Colors**
   - Click: **Custom** tab
How To: Test Color Contrast

- You’ll get a box similar to this one:

- These are the RGB (red, green, blue) numbers. Write these down for both text and background colors.
How To: Test Color Contrast

2. Convert RGB numbers to a Hex number.
   - Go to www.javascripter.net/faq/rgbtotext.htm.
   - Type in the R, G and B numbers and click Convert to Text.
     
     | R: 79 | G: 129 | B: 189 | Convert to Hex | 4F81BD |

   - The 6 digits are the Hex (hex = 6) number for the color.
   - Get the Hex numbers for both text and background.
   - Cheatsheet: white = FFFFFFFF and black = 000000.
How To: Test Color Contrast

3. Test the contrast between text/background.

webaim.org/resources/contrastchecker/

Foreground color: #cf4e4e
Background color: #4f81bd

Contrast Ratio: 1.07:1

Normal Text

WCAG AA: Fail
WCAG AAA: Fail
Sample: I am normal text
### Don’t Use Color Alone to Convey Info

<table>
<thead>
<tr>
<th>Project</th>
<th>Due Date</th>
<th>Completed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web comparison report</td>
<td>September 15</td>
<td>X</td>
</tr>
<tr>
<td>Webinar materials</td>
<td>September 20</td>
<td>X</td>
</tr>
<tr>
<td>Survey questionnaire</td>
<td>September 23</td>
<td>X</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Project</th>
<th>Due Date</th>
<th>Completed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web comparison report</td>
<td>September 15</td>
<td>Y</td>
</tr>
<tr>
<td>Webinar materials</td>
<td>September 20</td>
<td>N</td>
</tr>
<tr>
<td>Survey questionnaire</td>
<td>September 23</td>
<td>N</td>
</tr>
</tbody>
</table>
## Don’t Use Color Alone to Convey Info

<table>
<thead>
<tr>
<th>Project</th>
<th>Due Date</th>
<th>Completed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web comparison report</td>
<td>September 15</td>
<td>X</td>
</tr>
<tr>
<td>Webinar materials</td>
<td>September 20</td>
<td>X</td>
</tr>
<tr>
<td>Survey questionnaire</td>
<td>September 23</td>
<td>X</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Project</th>
<th>Due Date</th>
<th>Completed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web comparison report</td>
<td>September 15</td>
<td>Y</td>
</tr>
<tr>
<td>Webinar materials</td>
<td>September 20</td>
<td>N</td>
</tr>
<tr>
<td>Survey questionnaire</td>
<td>September 23</td>
<td>N</td>
</tr>
</tbody>
</table>
Don’t Use Format Alone to Convey Info

Changes from last year are in **bold** type.

**ALGEBRA 1   2007-2008**

**PRESUMED KNOWLEDGE**
1. Distance - Rate formula
3. Pythagorean Theorem

**SPECIFIC TOPICS FOR CONTESTS**

**Contest I**
1. Simplifying numeric expressions
2. Performing operations with real numbers
3. Venn Diagrams
4. Number Patterns
5. Prime Factorization
6. Divisibility Tests
Avoid Content in Header/Footer

- JAWS won’t read headers or footers in Word, so don’t put anything important there.
Avoid Text Boxes

- You have no control over when – or if – the screen reader will find the text box and in what order it will – or will not – read it.

- Recommend using tables or columns for layout if possible.

- Saving as PDF is better than distributing a Word document if you’ve used text boxes, but things still might be out of order.
Avoid Text Boxes

Text boxes are EVIL!

Carol is trading in her office chair...

For a lounge chair!

Please join us in her retirement celebration!

Saturday, April 2nd at 7:00pm
Larry and Carol’s Home
RSVP - 507-555-1000 - Regrets Only

Don’t forget your bathing suit!

Bring your favorite photo of Carol.
WordArt = Text Boxes

So, avoid WordArt.
Intended to be read onscreen?
- Easily readable Sans Serif fonts like Arial, Tahoma, Verdana

For print publication?
- Easily readable Serif fonts like Times New Roman or Georgia are OK
- At least 12 point in size
Alternate Formats

- Large print version of printed publications at least 18 point in size
- If an online document is particularly complex in layout, like an annual report, consider having a link to a “large print text-only” version. Can be used both by low vision individuals and by blind individuals with AT.
Alternate Formats

PAGE 1:

2013 Annual Report
Maryland State Department of Education
Division of Rehabilitation Services

PAGE 2:
Greetings:
As we move forward to a new year, we have the opportunity to look back and reflect on the numerous successes of the remarkable programs and services provided through the Maryland State Department of Education’s Division of Rehabilitation Services (DORS). DORS has made it possible for thousands of Maryland citizens with disabilities to find true independence, become employed, and have remarkable futures – often far beyond where they may have imagined without receiving such support.

This report features some of the innovative DORS programs that help people with disabilities transition to higher education, vocational training, and employment. The success of the programs also translates into success for Maryland businesses as DORS is
“Automated” Testing

Microsoft Windows 2010 and higher comes with an accessibility checker.

- Click **File** tab
- Click **Check for Issues** button
- Click **Check Accessibility**
“Automated” Testing

- **Error** – Content that makes a file very difficult or impossible for people with disabilities to understand.
- **Warning** – Content that in most, but not all, cases makes a file difficult for people with disabilities to understand.
- **Tip** – Content that people with disabilities can understand, but that might be better organized or presented in a way that would improve their experience.

https://support.office.com/en-us/article/Rules-used-by-the-Accessibility-Checker-651e08f2-0fc3-4e10-aaca-74b4a67101c1
Save As PDF

If everything is set up OK in Word, the resulting PDF should be accessible*.

*Maybe not perfect. But pretty close.
“Save as PDF” in Word

Word 2010 + Adobe Acrobat

- File > Save as Adobe PDF > Options:
  - Enable Accessibility and Reflow with tagged Adobe PDF
  - Create Bookmarks
  - Convert Word Headings to Bookmarks

- OK > Save
“Save as PDF” in Word

Word 2010 without Adobe Acrobat

☐ File > Save As > Adobe PDF >
Save as Type > PDF > Options:

☑ Document structure tags for accessibility

☐ OK > Save
“Save as PDF” in Word

Word 2013 & 2016

☐ File > Export > Save as PDF/XPS

Document > Options:

☑ Create Bookmarks using:
  ☐ Headings

☑ Document structure tags for accessibility

☐ OK > Publish
DO NOT!!!
DO NOT!!!

- Do not use a third-party online service to convert a Word document to PDF.
- Most do not create accessible PDFs.
Avoid “Scan to PDF”

A scanned document is generally NOT accessible.

It is just a photograph of a piece of paper.
“Generally?”

There are exceptions:

- See if scanner can be set to do “OCR” (Optical Character Recognition) automatically or create a “searchable” PDF.

- Scan directly from Adobe Acrobat (not Reader), setting the configuration for “OCR” or “searchable.”

Both require crystal clear, crisp, legible, sharp paper documents!
Trust Google?

Google Docs can do this accessibly:
- Headings via Styles
- Table of Contents
- Bulleted Lists
- Numbered Lists
- Columns

Google Docs **cannot** do this accessibly:
- Data Tables – no way to indicate header rows/columns
- Convert to tagged accessible PDF

NOTE: A Chrome add-on called GrackleDocs is available. It will check your document, help you fix any problems, including tables, and convert the Google Doc to a tagged accessible PDF.
PART IV. PERFORMANCE STANDARDS

PERFORMANCE STANDARDS - For each essential job function described in Part II, list the standard(s) necessary for satisfactory performance. If additional space is required, attach a separate sheet.

1. Evidence of record will demonstrate that incoming and outgoing correspondence will be processed efficiently on day of receipt; all documents for the Program Manager’s signature or approval will be reviewed for correct content, spelling, punctuation, grammar, calculations and formation; office, reference and follow-up files will be kept current. Inquiries, complaints and requests will be appropriately screened and responded to or referred within one hour of receipt.

2. Evidence of record will demonstrate that position works independently to manage and monitor staff security levels, supervises and assists support staff in four (4) offices, makes decisions regarding procedures to written and verbal inquiries from consumers, manages and monitors personnel policy and procedure, monitors and processes vendor approvals within 24 hours of receipt, and responds to other outside inquiries.